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LSO Configuration 

This section details how you should configure your LSO-AE 
Authoring Tool and LSO-AE Repository Explorer after 
successful installation. 

Configuring the SAP Learning Solution Authoring 

Environment (LSO) 

1. Open  the SAP Learning Solution “Authoring Tool” 

2. Go to the “Tools” menu and select “Customize” 
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3. Ensure all the boxes checked in the “General” tab are checked in your version 

also.  You can leave the first two unchecked, if you do not want the publishing 

wizard to run on launch. 

4. Click on the “Wizard” tab, make sure everything is checked. 
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5. Click on the “Profile” tab 

6. For the role of “Subject Matter Expert” ensure that everything is checked 
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7. While still on the profile tab, click the dropdown menu next to “Subject 

Matter Expert” and select “Instructional Designer.” 

 

8. Ensure all these boxes are checked as well. 
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9. Select the “Messages” tab and ensure that everything is checked here as well. 

 

 
 

10. Click “OK” when finished. 

11. Next, go back to the “Tools” menu and select “Configuration” 
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12. The “Associations” tab is the first one that comes up.  Make sure your 

Associations tab looks like this: 
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13. Select the “External Meta Data” tab, yours should look like this: 
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14. Select the “Online” tab and ensure that the option “Start Online” is checked. 
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15. Select the “Repository” tab.  There shouldn’t be anything to select or change 

here.  The “Root Folder” path indicates your local repository path for Sandbox 

or Production, and will change depending on which system you log into. 
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16. Click the small arrow pointing to the right of the “Repository” tab to get to the 

last tab in the Configuration window.  
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17. Select the “Content Player” tab and make sure your version looks like this: 

 

 

 

18. Click “OK” to exit the Configuration screen and save your changes. 

19. Exit the LSO Authoring Environment by going to the “File” menu and selecting 

“Exit” 
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Publish to Sandbox LSO 

This section details how you should publish your courses to the 
LSO Sandbox.  Course Authors and Course Publishers can both 
publish to Sandbox, and this is where the majority of  your course 
testing should occur before you publish to LSO Production.  We’ll 
cover how you should “wrap” your course, the order you should open 
your tools in and the publishing  process itself. 
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“Wrapping” your courses: 

 The Authoring tool is set up to accept .zip files of your published wbt content. 

 When your PowerPoint is finished, use Articulate (or whatever tool you use to 

wrap courses.) to publish your course. 

 Zip the entire course structure into a .zip file as shown below: 

 

 
 

 You want to have your entire course structure in the ROOT of the .zip file, do 

not place it in another folder before zipping it. 
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“Opening” Your Publishing Tools: 

There is a specific order you need to open your publishing tools in so that you can 

publish and version your courses correctly. 

1. From your programs menu, open the SAP Learning Solution Folder and select 

the “Authoring Tool” 

 

2. You should then be presented with a login screen.  Use these settings to login 

to Sandbox LSO: 

a. System Number:  02 

b. Server Host:  ql6dca0u.state.pa.us 

c. Client:  110 

d. User Name:  The format is baxxpub, where “xx” is your agency 

number 

e. password: imagine (all lower case) 

3. These settings will stay (except for the password) after the 1st successful login. 
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4. You are now logged into the LSO Authoring Environment. 

5. Next, we need to start the LSO Repository Explorer.   You must open the 

Repository Explorer from within your Authoring Environment. 

6. Click this button to start the Repository Explorer: 
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7. Your screen should now look like this: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Next, click the “Connect” button in the Master Repository to complete logging 

into the Repository Explorer.  
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9. You will be presented with your final login screen.  

a. Username:  baxxpub (where “xx” is your agency number) 

b. Password:  Imagine#1 

c. Click “OK” 

 

 

 

 

 

 

 

10. You should now be fully logged into the LSO Authoring Environment, your 

screen should look like this: 
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11. You can now click the “End” button at the bottom of the Repository Explorer 

to hide it from view.  The Repository Explorer will still be running after you do 

this, the “End” button merely hides it from view so you can work in the 

Authoring Environment.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. You are now ready to publish and version courses. 
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Publishing to Sandbox LSO: 

Follow these steps to publish to Sandbox: 

 

 1. Start the process using the menu path below. 
 

 
2. Select the start  button icon on your computer 

 

 3. Select the SAP Learning Solution Authoring Tool  menu item  
 

 4. Select the Tools > Wizards > Import as Reusable Media Object 
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5. Select:  Add Packed File (e.g *inp, *zip, *pif) 

 

 
 

 

5
. 

  

 From this point on, follow the instructions provided by the Wizard.  It will prompt you on  
which folder the content is coming from and where it should go.   
The following steps detail these actions. 
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6. After selecting “Add Packed File” this is what your screen should look like.  
Click the folder icon here to find your zipped content you would like to 
import.  
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7. Browse your system to find the packed file as below: 
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8. Select the Select Packed File from the desired location.  It will populate in 
the “File” field below as shown.  Click “Next.” 
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9. Select “Accept Current List” and click “Next.” 
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10. Click “Next.” 
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11. Click “Start” to import your content.  When this operation is complete Click 
“Next.” 
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12. Click “Convert.”  When this operation is complete Click “Next.” 
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13. Click “Next.”  You will note there is a checkbox here if you are importing a 
new version of a previous course.  Leave this unchecked for now.  We will 
cover how to use this and version your courses in the “Versioning your 
Courses” section of this desk guide. 
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14. Click “Next.” 
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15. Click “Next.” 
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16. Click “Next.” 
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17. Now you will pick a storage folder for your course in the Local Repository.  
Click the folder icon highlighted here to browse to your local repository to 
find the course folder you would like this WBT to reside in.  These folders 

should have been built during the Set Up process for the LSOAE.  If 
they have not, log in to your Repository Explorer and use the “Copy” 
button to copy your agency folder from your Master Repository to your 
local repository. 
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18. After clicking the folder icon in the previous step, you will be presented 
with a window to browse your Local Repository for your agency folder.  
Find the folder, highlight it and click the “Select” button. 

 

 
 

 

  
 
 



 

 36 

19. Your agency storage folder should now appear in the “Storage Folder” field 
below.   Click “Next.” To continue. 
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20. Click “Next.”   
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21. Click the “Store” button to place your course in your Local Repository 
agency folder that you selected in the previous step.  When this operation 
is complete click “Next.”   
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22. Click “Finish.”   
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23. You can now test your content in the Authoring Tool.  Simply click the 

Globe icon here.  When you do this, you will be notified that your work was saved 

click “OK” when prompted.    
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24. Click “OK” when prompted again.    
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25. The system will open a secondary window in Internet Explorer to play the 
content.  This is your opportunity to walk through the content.  You should 
test for the following: 

 
- Screen Resolution has been properly set 
- Screen colors/graphics are appearing as expected 
- Links are accessible 
- Content has an overall look and feel to your agency standards 

 
This is not a time to find edits in content, content should be reviewed prior 
to this point.  If edits to content are found, take the content back to your 
Content Tool, make the changes, repackage then upload the content again. 
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26. Once you have reviewed the entire content, select the Log off link at the bottom of the 

 screen and close the window to return to the LSOAE Authoring Tool.  
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27. After logging off the content player, you are returned to the LSO Authoring 
tool.  Next Select File Save All: 
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28. Click “OK” 
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29. Click the “File Menu” and select “Close all Files” to clear your workspace.  
You are now ready to publish another WBT OR check your content in to the 
Master Repository.  We’ll cover checking your content in next. 
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Checking your content in to the Sandbox Master 

Repository: 

You’ve successfully published your content to the Sandbox Local Repository.  Now 

we’ll cover how to “Check your content in” to the LSO Sandbox MASTER Repository.  

The Local Repository is basically your Root folder on your PC or shared drive.  The 

Master Repository resides inside the LSO system, and once your content is in the 

Master Repository, you can attach it to a WBT Course type and test the content live in 

the LSO Sandbox before publishing it to Production. 

It is strongly recommended to test your course extensively and work out all the 

issues in Sandbox before publishing to Production LSO. 

1. Start your Repository Explorer by clicking the “Repository Explorer” button 
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2. Start your Repository Explorer by clicking the “Repository Explorer” button.  

You should already be logged in to the Repository Explorer, if not click the 

“Connect” button and log in. 
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3. After the logon is complete, you will see all of the agency folders to on the 
right hand side (Master Repository) and only your files on the left.  You will 
need to locate the WBT you just published to begin the process of checking it 
in to the Master Repository.  Files that have been published to your local 
repository that have not been published to the Master Repository appear 
with a red exclamation point next to them as below.  Select the course you 
want to check-in by clicking on it once to highlight it. 
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4. Select the Check In button in the center of the screen.  
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5. Click “Next.” 
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6. After clicking “Next” the first time, you are brought to this step.  Make sure 
you do the following here before clicking “Next” again: 

a. Uncheck “Use delta versioning when storing in Master Repository” 

b. Check “Release objects after check-in” 

c. Check “Publish learning nets after release” 

When your screen looks like the example below, click “Next.”  
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7. Click “Next.”  
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8. The course will begin to “Check in” to the Master Repository. 
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9. When the above step is finished running, your screen should look like the 
example below.  Click “Next” to continue. 
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10. After clicking next, the course will go through an “Object Check.” 
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11. When the above step is finished running, your screen should look like the 
example below.  Make sure “Publish learning nets after release” is still 
checked.   Click “Next” to continue. 
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12. You will see this screen as the course is prepared for final publication.  Click 
“Next” after the blue-bar goes all the way to the right and process finishes. 
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13. This screen shows you the learning strategy your course uses.  Click ‘Next” to 
continue. 
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14. There is some information you need to input here: 
a. Minor or Major Change – If you are publishing the course for the first 

time, you can leave this as a minor change.  (We’ll cover minor and 
major changes when we discuss versioning your web based trainings 
in the next section of this desk guide.) 

b. Language defaults to Engligh 

c. The fields of Author, Editor, Publisher and Provider are are searchable 
fields when looking for your web based training content, so it is best 
practice to place something in these fields similar to what you see 
below. 

d. Ensure that “Create Offline Course Date” is checked. 
 

Click “Next” when you are ready to continue. 
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15. Your course now proceeds through the final publishing process as below: 
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16. Success!  Your course has now been checked in to the LSO Master Repository.  
Click “Finish” to exit the check-in process. 
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17. You can see that the course you just checked in has a green dot next to it, 
rather than a red exclamation point.  This is another visual cue to inform you 
that your course was checked into the Master Repository successfully. 
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18. If you highlight the course in the Master Repository (as shown below,) you 
can click the Content Player Button (the small globe icon,) to play your 
content in the Master Repository and ensure that it behaves as expected. 
 

 

Now that you have published and checked the course into Sandbox, you can do one of 
several things: 

 Attach it to a WBT Course Type in Sandbox and test the course registration, 
content and completion in Sandbox LSO.  See your “LSO Admin Training Guide” for 
instructions on how to create WBT Course Types and attach WBT content to them. 

 If there are errors, you can republish a new version of the course and check it into 
Sandbox again for further testing (we’ll cover versioning in the next section of this 
desk guide.) 
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Versioning your WBTs 

This section details how you should version your web based 
trainings.  You have the ability to update or fix your web based 
trainings with either Minor or Major changes.  There are different 
implications for the end-user depending on which strategy you choose.  
We’ll cover both next. 

What is a “Minor” or “Major” versioning change? 

1. Minor Versioning Change – 

o  A minor versioning change is when you need to update something in 

the course, that doesn’t really affect the content or message being 

conveyed; things like typos, changes in graphics, broken links etc… 

o When you update a WBT with a “Minor Change” any learners that are 

enrolled in the WBT and/or have a partial complete, can continue to 

take and complete the version they are enrolled in.  All new learners 

who book the WBT after the minor change will get the new version of 

the course. 

2. Major Versioning Change – 

o  A major versioning change is when you need to update a major 

portion of the course or content has changed significantly 

o When you update a WBT with a “Major Change” any learners that are 

enrolled in the WBT and/or have a partial complete, will be prompted 

to update to the NEW version of the course.  Their progress will not 

be saved and they will need to start the course over.  All new learners 

who book the WBT after the major change, will get the new version of 

the course. 
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o In most cases, you will use “Minor Changes.”  If the course has 

changed so significantly that you are considering a major change, you 

might want to simply create a whole new version of the course, and 

attach it to a new WBT course type.   

 

To publish a new version of your course (as a minor or major change,) do the 

following: 

1. Open your “Authoring Tool” and “Repository Explorer” exactly as described in 

the “Opening” Your Publishing Tools” section on pages 16 – 20 of this guide. 
2. Publish your course as normal till you get to step #13 on page 30 of this guide.  

You should then be at the screen displayed below.   
3. IMPORTANT:  To properly version your course, check the box here “Files are 

a new version of files already checked in.”   
4. Click “Next” 
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5. Next, you need to choose the precursor version of the file you are publishing 

a new version of here.  Basically you need to find the old version of this 

course in the Master Repository so the LSO knows which course to version.  

Click the file folder icon here to start this process: 
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6. Clicking the folder icon opens the Folder structure of the Master Repository.  

Navigate to your agency folder and open it: 

 

7. Find the WBT you are versioning and open that: 
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8. Inside the WBT folder is your previous version.  Select the *.crs file by clicking 

it once, then click the “Select” button: 

 

 

9. The precursor file should now populate your publish screen like so.  Click 

“Next” to continue. 

 



 

 70 

10. Next you should get a warning telling you that the copy of the WBT in your 

local repository is about to be deleted and replaced with the new copy.  Click 

“Yes” for this. 

 

 

11. Finish the authoring process as normal after this step. 

12. Use the Repository Explorer to check your course in to the Master Repository 

as normal.  This is covered in pages 47-59 of this guide. 

13. When you get to this step detailed below, you can select whether the new 

version of the WBT is a Major or Minor change: 
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14. Click “Next” then ‘Finish” to complete the versioning process: 
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15. You will now notice we have two versions of the course we just published in 

the Master Repository.  We need to flag the first version as obsolete to 

complete the versioning process.  Click the earlier version of the course (v1) 

so it is highlighted. 
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16. Right click the older version and select “Flag as Obsolete.” 

 

 

17. Click “Yes” for this dialogue box. 
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18. The old version is now obsolete.  Obsolete courses will always stay in your 

Master Repository.  Best practice with the SAP LSO is to never delete 

anything; hence older versions of your courses will always be here flagged as 

obsolete.
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Publishing to Production 

LSO 

This section details how you should change settings to publish to 
Production LSO. 

3. Some points to remember – 

o  All of your testing of the course should be finished by now.  Test your 

course and keep publishing it to LSO Sandbox till you are sure the 

course plays and tracks completions correctly. 

o Only those employees with the specific role of LSO Publisher should 

be performing the operations detailed in this section. 

 

1. To begin, close, then re-open the LSO Authoring tool.  When you do you 

should be presented with the login screen as shown in chapter 1: 
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2. Change the URL in the “Server Host” line to the following: 

a. pl1dca0u.state.pa.us 

 

 

4. Your User Name will remain the same 

5. The password for Production is different.  Those with the LSO Publisher role 

have this password.  If you have the Publishing role but do not have this 

password, please contact the LSO System Admins at:   

RA-lsoadministrator@pa.gov and we will supply the password. 

 

3. Click “OK” when you have your Server Host, User Name and Password in 

System Logon screen. 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:RA-lsoadministrator@pa.gov
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4. If you have just been working in Sandbox previously, you might get this 

warning screen.   Don’t’ worry, just click OK and we’ll switch our Local 

Repository in the next step. 

 

 

5. Click the ‘Repository Explorer” button as before to login to the Repository 

Explorer: 
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6. BEFORE you click connect in the LSO Production Repository Explorer, you 

must switch your Local Work Area first.   To do this, click the “Create” button 

here to create a “Production” workspace. 

 

 

 

 

7. Type “Production” in the “Name” field for the new workspace, then click 

“OK.” 
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8. Click “OK” for this “Save All Changes” dialogue box.  You can also opt to check 

the box “Do not display this message again.” 

 

 

 

 

9. Your Local Repository should now reflect the new workspace.  To get to this 

workspace in future, simple select it from the drop-down menu here.  You do 

not have to recreate it each time. Click the “Connect” button in the right pane 

to connect to the LSO Production Master Repository. 
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10. The password for Production is different.  Those with the LSO Publisher role 

have this password.  If you have the Publishing role but do not have this 

password, please contact the LSO System Admins at:   

RA-lsoadministrator@pa.gov and we will supply the password.  Click OK after 

the User Name and the Password are entered. 
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11. You are now connected to the Production LSO Master Repository.  The last 

thing you need to do before you can publish to production, is copy your 

agency folders to the new Production workspace you just created.  To do this, 

highlight your agency folder in the Master Repository, then click the “Copy” 

button in the middle of the screen to copy that folder to your local repository.  

JUST the folder will copy over, not any content inside of it.  This is normal. 

 

Helpful Hint:  You can hold the “Shift” key down and select multiple folders to copy 

over at once.  
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12. The “Copy Wizard” will come up, make sure the checkbox titled “Add All 

Dependent Objects.” Is checked and click “Next.” 

 

 

13. Click “Next” twice more, then click “Finish.” 
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14. Your folders have been successfully copied over to your Production Local 

Repository and you are now ready to publish to Production LSO. 

 

 

 

In summary, to Publish to Production LSO: 

1. Open the LSO Authoring Tool, sign in with the Production Server Host, 

standard User Name and Production Password. 

2. Open the Repository Explorer from within the LSO Authoring Tool. 

3. Switch your workspace to “Production” by using the drop-down menu next to 

the “Local Work Area” at the top of the Repository Explorer. 

4. Click “Connect” on the Master Repository. 

5. Sign in with the standard User Name and Production Password. 

6. Publish, version and check-in as normal. 


